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Product Overview
You can use the Colorway Kit for Cinema 4D to export a project out of Cinema 4D with tagged parts
and lights, for use in Colorway.

The Colorway Kit allows you to tag parts and lights in your current project and export it fromCinema 4D (C4D) as a
Colorway DeepColor (.dci) file.

This can then be opened in Colorway or Colorway Presenter. You can experiment with different looks in Colorway by
applying different materials and adjusting the lights. See the Colorway User Guide formore information about using
Colorway.

When you're happy with a look in Colorway, you can choose to export it out as a .lks file, which can then be read
back in to C4D using the Colorway Kit.
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Installation
This chapter covers installing Colorway Kit for C4D on Windows and Mac.

Installing Colorway Kit for C4D on Windows

NOTE: You need to have Cinema 4D installed on your PC before installing Colorway Kit for C4D.

To install Colorway Kit onWindows, complete the following steps:

1. Download the correct .exe installation file fromourwebsite at www.thefoundry.co.uk/products/colorway/kits/.

2. Navigate to the .exe file and double-click it to install Colorway Kit.

3. Click Run to launch the Colorway Kit Setup Wizard.

4. ClickNext.

5. Comply to the license agreement by selecting I accept the agreement, and then pressNext.

The installation location defaults to C:\ProgramFiles\MAXON\CINEMA 4D R15\plugins.

6. Click Install and then when the process is complete, click Finish.
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Installing Colorway Kit for C4D on Mac

To install Colorway Kit onMac, complete the following steps:

1. Download the correct .dmg installation file fromourwebsite at
www.thefoundry.co.uk/products/colorway/kits/.

2. Navigate to the .dmg file and double-click it to launch the Installer.

3. Click Continue.

4. The installation location defaults to /Applications/MAXON/CINEMA 4D R15/plugins. To accept the default,
click Continue.

5. You are presented with the EULA. Click Continue.

6. An agreement dialog opens and you can click Disagree,Agree, orRead License.

7. Click Install and then when the process is complete, click Close.

INSTALLATION |
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Licensing

Obtaining a License
To obtain a license, do the following:

1. In C4D, select File > Export > Colorway DeepColor (*.dci).

As you don't have a license already, a dialog displays asking how you would like to proceed.

2. Click Try colorway for Cinema4d.

3. If you have one already, enter your Foundry e-mail address and password, and then click Login. If you don't
have a Foundry e-mail account, create an account and sign in.
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A trial license is generated for you. After the generation is complete, you can begin using Colorway Kit for C4D
immediately.

LICENSING |



Using the Colorway Kit
This chapter covers using light and part tags, exporting out of C4D, and importing back into C4D.

Light Tags
You can use the Colorway Kit to add Colorway light tags to lights in C4D. When the file is exported and opened in
Colorway, the tagged lights are selectable for editing in Colorway.

Tagging a Light

You can add a Colorway Light tag to a light in your C4D project by doing the following:

1. Select the light you want to tag in the left column of the Projects panel.

2. Select the Tags tab in the Projects panel by clicking on it.

3. Select ColorwayKit Tags > Colorway Light.
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This displays a small Colorway icon next to the light showing that it has been tagged. The tagged light is then
selectable in Colorway when the project is imported.

Light Parameters and Options

When you add a Colorway light tag to a light in C4D, you are presented with some parameters. To view the
parameters, select the tagged light in the Projects panel; the parameters are displayed beneath the Projects panel.
Ensure theColorway Light tab is selected.

Group Option

You can use an optional group name for light tags when exporting your project to Colorway. If this is left blank, the
name of the object that the tag is assigned to, is used.

To add a light tag to a group, in theGroup text field, enter a name for the group. Light tags with the same group
(which was either enteredmanually, or derived from the object name) form a single, editable light in Colorway.

NOTE: If you want to be able to edit an individual light in Colorway, ensure the light tag has a unique name
or group so it remains as an individual light. For instance, if you have a light called table lampwith no
group set on the tag, and you have set the group on several other light tags to be table lamp, they are
grouped together because the final group for all those lights is table lamp. This is due to the fact that the
first light uses its name, as no group is set on the tag.

USING THE COLORWAY KIT |
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Hide Objects When Off

When a light is disabled in Colorway, you can select theHide Objects When Off checkbox to turn the RenderMode
of the luminous object off. This hides the light’s geometry.

Normally, when luminous objects are rendered as lights, turning the light off simply disables the Luminance channel
of the relevant materials. This is to allow the object to remain visible in the scene. This is useful when rendering strip-
lights, for example, where the camera visibility of the ‘tube’ is an important part of the rendered image. Sometimes,
you don’t want to see the actual geometry when a light ismuted, as the geometry produces unwanted shadows in
global illumination.

NOTE: This option applies to all objects affected by the specific tag it is set on. If you have two sets of
objects with light tags in different parts of your scene, but with the same group name, you can
independently set this option for each tag, and the render behaves as expected.

Select Objects

Clicking Select Objects, selects all the objects that are part of the light group that the tag relates to.

Part Tags
You can use the Colorway Kit to add Colorway part tags to objects in C4D. When the file is exported and opened in
Colorway, the tagged parts are selectable for editing in Colorway.

Tagging a Part

You can tag a part in your C4D project to be selectable in Colorway, by doing the following:

1. Select the part you want to tag in the Projects panel.

2. Select the Tags tab by clicking on it.

3. Select ColorwayKit Tags > Colorway Part.

This displays a small Colorway icon next to the part showing that it has been tagged. The tagged part is then
selectable in Colorway when the project is imported.

Part Parameters and Options

When you add a Colorway part tag, to a part in C4D, you are presented with some parameters. To view the
parameters, select the part in the Projects panel; the parameters are displayed beneath the Projects panel. Ensure

USING THE COLORWAY KIT | PART TAGS
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theColorway Part tab is selected.

Part Name

You can enter a name for your tagged part by typing it in the Part Name text field. This name is then used in
Colorway. If this is left blank, the name of the object that the tag is assigned to is used.

All objects with the same part name aremerged into a single part in Colorway.

NOTE: If you want to be able to edit an individual object in Colorway, ensure the object in C4D has a
different name or part name so it remains as an individual part.

Select Objects

Clicking this button selects all the objects that have the same Part Name, and are therefore in the same group.

Select Untagged Objects

You can select Plugins > Colorway - Select Untagged Objects to select any objects in your C4D project that don’t
have either a Colorway part tag or a Colorway light tag.

Marking and Un-marking Materials for Colorway

You can use the controls in the Pluginsmenu to automatically mark or un-mark materials to create parts in
Colorway when you export your project.

USING THE COLORWAY KIT | PART TAGS
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Exporting

Exporting a Project for Colorway

To export a project fromC4D, do the following:

1. Select File > Export > Colorway DeepColor (*.dci).

Alternatively, you can export a project by selecting Plugins > Export DeepColor File (.dci).

USING THE COLORWAY KIT | EXPORTING
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A dialog appears with any errors listed, with details explaining how they have occurred.

You can choose to ignore these errors by clicking Continue, or you can click Cancel to go back and rectify the
errors before exporting. If the errors cannot be ignored, Colorway Kit in C4D does not present you with an
option to Continue. See Trouble Shooting formore information.

2. After clicking Continue, you are asked to specify a location to export to. Browse to the required location and
click Save.

An export dialog is then displayed asking whether you want to allow procedural textures. This option is enabled
by default. See Export Options formore information.

3. Select or deselect the checkbox (depending on your preferences), and then click Export.

Your project is exported to the specified location as a .dci file.

USING THE COLORWAY KIT | EXPORTING
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Export Options

Allow Procedural Textures

The exporter aims to neutralize light andmaterial colors so adjustments can bemade in Colorway. If Colorway does
not recognize a procedural texture in amaterial color, or a light’s luminance slot, one of two things can happen:

• With this option disabled, the unknown shader is removed so a neutral render can be produced. This allows full
adjustments to bemade in Colorway, but can affect the rendered image.

• If this option is enabled, any materials with unrecognized shaders are left as is, and the result of these procedural
textures are baked into the render. Thismay, ormay not be desirable, depending on the contributions it makes to
the image. A simplemonochrome noise, for example, could add valuable variation without limiting color
adjustment in Colorway. However, a strong, saturated color could severely limit the changes a user canmake later
on.

Importing
When you want to import a Colorway project into C4D, you need to merge the new file with the original file that was
created in C4D.

Merging a Project into C4D

When you're happy with a look in Colorway, you can export it as a .lks file. This can then be imported into C4D using
the Colorway Kit for C4D. To import a project, do the following:

1. Ensure you have the original file open in C4D.

The imported file ismerged with the original file.

2. Click File >Merge.

Alternatively, you can select Plugins > Import Look...

A file browser is displayed.

USING THE COLORWAY KIT | IMPORTING
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3. Navigate to the .lks file that you exported fromColorway, select it, and then clickOpen.

An Import Look options dialog is displayed. See Import Parameters and Options formore information.

4. Set the required options, and then click Import.

A warning dialog displays, detailing any errors that have occured. See Trouble Shooting formore information.

5. ClickOK.

Import Parameters and Options

When you import a project, you are presented with some parameters.

USING THE COLORWAY KIT | IMPORTING
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Look

Use the Look dropdown to select which look should be applied to the scene. The default Look – As Saved, restores
the render as seen in Colorway when saving, regardless of whether it was saved to a specific look of its own or not.

Restore

You can select the Lights checkbox for the look to be applied to the lights in C4D,mapping them to the lights that
were in the Colorway project.

Select theMaterials checkbox for the look to be applied to thematerials and parts in C4D,mapping them to the
materials and parts that were in the Colorway project.

Preserve changes made since export

Select the Preserve changes made since export checkbox to allow any changes in the look to be applied relative
to the current scene values. For example, if the brightness of a light has been changed in the scene, and the
brightness is reduced by half in the look, when applied, the current scene value of the same light is also reduced by
half, preserving the local changes. Thismeans the final render would not match Colorway, but the intent of the
Colorway adjustment is honored. This is useful if you have had to make adjustments to your scene that produce
similar results, but using different settings - perhaps by using a different light.

If this option is disabled, then the brightness of the scene light is reduced to half of the original brightness on export,
ignoring the current state of the light in the scene. This option is disabled by default.

NOTE: If this option is disabled and the importer is unable to determine the original values from the .lks
file, a warningmessage is displayed and the changes aremade relative to the current values.

USING THE COLORWAY KIT | IMPORTING



Trouble Shooting
When you are performing an action using Colorway Kit, like exporting a project for example,
Colorway Kit has an in-depth error message dialog that provides you with details of potential errors
related to your project and the action you are trying to perform.

Warning/Error Messages and Meanings
Below is a list of errormessages and theirmeanings:

Error Message The Meaning

Unable to determine the exact light color from
the material <Material> adjustments may be
limited.

OR

Unable to determine the exact surface color,
adjustments may be limited.

In order to allow color changes within the Colorway
application, the exporter attempts to work out the
resulting color of lights and part materials in your scene.
These are reset to white for the render to allow full
adjustment in Colorway. Thismessage is displayed if the
material setup is complex or contains procedural textures
and the exporter cannot determine an accurate final
color. As a result, some colorationmay remain in your
render, and adjustments in Colorway are limited. If you
wish, you can uncheck theAllow Procedural Textures
option in the Export dialog, and colorway removes any
textures that it cannot represent when rendering.
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Adjusting light color by a significant amount,
renders may be clipped.

OR

Renders will adjust Luminance color of
<Material> by a significant amount, they may
be clipped.

OR

Adjusting material color by a significant
amount, renders may be clipped.

In order to allow color adjustments in Colorway, the colors
of lights andmaterials are reset to white during rendering.
If the current color is set to a particularly dark value, then
this neutralizationmay increase the brightness of the
object in renders by such an amount that clipping occurs.

Oneway to work around this is to use reduced brightness,
instead of a dark color to decrease illumination or object
color.

Colorway only supports a limited set of
adjustments for <Some Light Type> lights.

Some of the C4D lights – for example the Physical Sky
and Environment lights – do not have straight-forward
brightness or color controls. As such, these are always
exported to Colorway as is. Thismeans it is not possible to
change the existing color in Colorway - instead you can
add an additional tint. It also means that with round-trip,
adjustmentsmay not re-apply correctly back in C4D.

<Sky> The material uses both color and
luminance. Only enable luminance to allow full
adjustments in Colorway.

As global illumination renders in C4D consider both the
color and luminance values of thematerial attached to a
Sky object, in a complex fashion, Colorway is unable to
allow full color control of Sky lights within the application.
Thismeans it is not possible to change the existing color in
Colorway - instead you can just add an additional tint. It
also means that with round-trip, adjustmentsmay not re-
apply correctly back in C4D. If the Color channel is
disabled, thenmore comprehensive adjustments are
possible.

'Linear Workflow' is disabled in your Project
Settings. There will be gamma shifts and
textures may not position correctly.

Colorway requires that C4D renders are performed in the
linear color space. If you don’t have Linear Workflow
enabled in your Project Settings, you can still render but
renders can have a gamma shift in Colorway, and texture
placementsmay be distorted. See the C4D Help if you are
unfamiliar with this option.

TROUBLE SHOOTING |
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Multiple Materials are assigned, exporting
values from <Material Name>

In Colorway, each part can have a singlematerial assigned
at any one time. If you combinemultiple C4D objects into
one part, they should all share the samematerial. If you
havemore than onematerial assigned to the part’s
objects, thismessage is displayed.

The color and textures you see in Colorway are taken
from the namedmaterial. In some cases, this is fine, and
as intended. For example, say you used twoMaterials,
with the same color, but different specular properties to
make some objectsmore shiny than others. If, however,
you have assigned several shaders with different colors, it
is unlikely to get the expected result in Colorway, as all
objects take the color of the named shader.

Localizing material <Material Name> to <Object
Name> (inherited from <Object Name>) may
cause texture placement to change. Please
manually assign material to this object or use
an object-independent mapping.

In order to create the Colorway file, we have to
temporarily adjust thematerials in your scene during
export. Youmay see this warning if objects you have
tagged to be parts inherit theirmaterials fromobjects that
use object-based texture placement higher up in the
object tree.

This is becausemappings like Flat, Spherical, and so on,
use the bounds of the object to determine their
placement. When the tag is re-assigned to just the objects
in the part, this can change the placement of the texture.

To work around this, either use an assignment location-
independent mapping (like Camera or UVW), ormanually
assign thematerial to the objects within the part (so that
it is not inherited) and visually ensure the resultant
texturemapping is correct.
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Tips and Limitations
This chapter provides you with tips and information on limitations.

Tips
• Render several light rigs in one export to provide a variety of options in Colorway.

• When setting up shaders, stick to monochrome procedural textures/noises/and so on, to allow full color
adjustment in Colorway.

• Whenmaking dark materials, use a low brightness and a normal color, rather than setting a dark color. This
prevents renders clipping when Colorway neutralizes the color during rendering.

• When setting up yourmaterials, try to always use theMultiply texturemixingmode, as it allows Colorway to re-
apply adjustmentsmade in the application. Othermodes, especially Normalmake it difficult to achieve the same
results when a look is re-applied.

• When using the Sky light, only enable the Luminance channel so adjustments fromColorway can be re-applied.

• If you keep your object hierarchy well-organized, tagging can becomemuch easier.

• Make sure your texture placementsminimize repeats in themain export. At present, the export bakes the current
placements into the Colorway file, so you won’t have asmuch freedom tomove/change/enlarge textures if they
are already tiled quite small in the render.

• Try andmake sure the illumination from any light (or group of lights) doesn’t create super-whites in the render -
otherwise, when turning the light down in Colorway, flat gray patches are produced.

• Make sure you only have onematerial per part, or if you need to havemultiple parts to create variation inmaterial
properties, make sure they have the same color.

• When possible, aim to use theMultipleMix Mode formaterials in C4D, as the default – Normal – masks any color
changes.

Limitations
• If you have a light based on a Physical Sky, you cannot apply tint adjustments that weremade in Colorway.

• Export of Texture Scale/Rotate/and so on, is not supported. Textures appear in Colorway with an identity
transform, and any existing tiling for example, is baked in.

• Import of textures during round-trip is not supported.
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• Blurry reflections are not supported.

• Selections are not supported, only whole objects can be assigned to parts.

• Extracting textures and colors from the Layered shader is not supported in Colorway. Where possiblemake use of
the base color of thematerial for overall tints and add simple bitmaps in the texture slot.

TIPS AND LIMITATIONS |



Appendix: EULA

End User License Agreement (EULA)
PLEASE READ THIS EULA CAREFULLY BEFOREORDERING ORDOWNLOADING ANY SOFTWARE FROM THISWEBSITE.
YOUR ATTENTION IS PARTICULARLYDRAWN TOCLAUSES 12 AND 13 WHEREWE LIMIT OUR LIABILITY TOUSERSOF
OUR SOFTWARE PRODUCTS.

IMPORTANTNOTICE TO ALL USERS: BYDOWNLOADING THIS SOFTWARE YOU ACKNOWLEDGE THAT YOU HAVE
READ THIS EULA, UNDERSTAND IT AND AGREE TOBE BOUND BY ITS TERMS AND CONDITIONS. IF YOU DONOT
AGREE TO THE TERMSOF THIS EULADONOTDOWNLOAD, INSTALL, COPYOR USE THE SOFTWARE.

IMPORTANTNOTICE TO CONSUMERS: YOU HAVE THE RIGHT TOWITHDRAW FROM YOUR TRANSACTIONWITHOUT
CHARGE AND WITHOUT REASON AT ANY TIME BEFOREDOWNLOADING OUR PRODUCT(S). HOWEVER YOU WILL
LOSE THIS RIGHTONCE YOU BEGIN TODOWNLOAD OUR PRODUCT(S). THIS DOES NOT AFFECT YOUR CONSUMER
RIGHTS IN RELATION TODEFECTIVE PRODUCTSOR SERVICES.

This END USER LICENSE AGREEMENT (this "EULA") is incorporated into the agreement between The Foundry
Visionmongers Limited, a company registered in England andWales, ("The Foundry"), and you, as either an individual
or a single company or other legal entity ("Licensee") on the terms of which you will purchase the products and
services of The Foundry (the “Agreement”).

1. GRANT OF LICENSE

1.1 Subject to the limitations of clause 3 and all the other terms of the Agreement, The Foundry grants to Licensee a
limited, non-transferable (subject to clause 2.1 (b) below) and non-exclusive license to download, install and use a
machine readable, object code version (subject to clause 4 below) of the software program identified in the
Agreement (the "Software") and accompanying user guide and other documentation (the "Documentation"), solely
for Licensee's own internal purposes (the "License"); provided, however, Licensee's right to download, install and use
the Software and theDocumentation is limited to those rights expressly set out in this EULA.

1.2 Some types of license in clause 2.1 limit the installation and use of the Software to the country in which Licensee
is based at the date of purchase (the “HomeCountry”), unless otherwise agreed in writing. Notwithstanding such
limits, Licenseemay still use the Software outside theHomeCountry if traveling or working outside theHome
Country on a temporary basis provided that such use does not exceed 70 days in aggregate in any rolling twelve
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month period or, in the case of a Licenseewho has purchased a fixed term license for less than twelvemonths, does
not exceed the number of days representing 20% of the term of the license.

1.3 Only to the extent that is proportionate to, and reasonably necessary to support, Licensee’s licensed use of the
Software in accordancewith the Agreement, Licenseemay (provided valid license keys have been obtained) install
the Software onmore than one computer, provided always that Licensee’s concurrent use of different installations
of the Software does not exceed the number of valid Licenses that Licensee has paid for.

2. LICENSE MODELS

2.1 For each product purchased, the License shall be one of the following types of license, and is subject to the
following. Please note that some licensingmodels do not apply to certain products. Whichever licensingmodel
applies, Licensee shall not at any one time usemore copies of the Software than the total number of valid licenses
purchased by Licensee.

(a) “Node Locked License”

If Licensee purchases a Node Locked License, Licensee shall install and use only a single copy of the Software on only
one computer at a time, whichmay be located anywhere in theHomeCountry.

(b) “Individual License”

If Licensee purchases an Individual License, Licenseewarrants and represents that Licensee is a natural person and
that only Licensee shall use the Software. Licenseemay assign the Individual License to another natural person
(“Assignee”); subject to Licensee (i) notifying The Foundry and obtaining its express written consent, (ii) paying an
administrative feewith respect to such transfer, and (iii) after transferring a single copy of the Software to the
Assignee, deleting any copies of the Software that Licenseemay have in Licensee’s possession, custody or power. An
Individual License entitles Licensee to use the Software on only one computer at a time, whichmay be located
anywhere and is not restricted to theHomeCountry.

(c) “Floating License”

If Licensee purchases a Floating License, use of the Softwaremay be at any site in theHomeCountry.

2.2 Some of the Softwaremay bemade available at concessionary rates as follows:

(a) “Educational License”

If Licensee has purchased the Software on the discount terms offered by The Foundry’s Educational Policy published
on its website (the “Educational Policy”), Licenseewarrants and represents to The Foundry as a condition of the
Agreement that: (i) (if Licensee is a natural person) he or she is a part-time or full-time student at the time of
purchase and will not use the Software for any commercial, professional or for-profit purposes; (ii) (if the Licensee is
not a natural person) it is an organization that will use the Software only for the purpose of training and instruction,
and for no other purpose, and (iii) Licenseewill at all times comply with the Educational Policy (as such policy may be
amended from time to time). Unless the Educational License is a Floating License, Licensee shall use the Software on
only one computer at a time.

APPENDIX: EULA |
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(b) “Personal Learning Edition License”

If the Software is a Personal Learning Edition (“PLE”), it will not require a license key to be issued to Licensee and will
have limited functionality as described in theDocumentation. Licenseemay use it only for the purpose of personal
or internal training and instruction, and for no other purpose. PLE versions of the Softwaremay not be used for
commercial, professional or for-profit purposes including, for the avoidance of doubt, the purpose of providing
training or instruction to third parties. Licensee shall use the Software on only one computer at a time.

(c) “MODO Steam Edition”

A version of MODOwith limited functionality as described in theDocumentation is available to purchase on discount
terms through Valve Corporation’s Steam store. If Licensee has purchased such version, Licenseewarrants and
represents to The Foundry as a condition of the Agreement that: (i) Licensee is a natural person; and (ii) Licenseewill
use the Software strictly through Steam and only for personal, recreational and non-commercial use, except only
that if Licensee uses the Software to create assets and content Licenseemay sell such assets and content through
Valve’s SteamWorkshop.

(d) “MODO indie” and “MARI indie”

Variants of MODO andMARI with limited functionality as described in theDocumentation are available to purchase
on discount terms through Valve Corporation’s Steam store. If Licensee has purchased such a variant, Licensee
warrants and represents to The Foundry as a condition of the Agreement that: (i) Licensee is a natural person; or (ii)
Licensee is an entity in the direct ownership of a single natural person; (iii) Licensee shall only access and/or use one
copy of either variant; and (iv) only Licensee shall use the Software.

(e) “Trial License”

Licenseemay register for a “Trial License” of the Software (not available for all products or in all regions ormarkets).
A Trial License lasts a limited specified period on the expiry of which the Softwarewill automatically cease to
function. Licensee shall use the Software on only one computer at a time.

(f) “Free License”

Licenseemay register for a “Free License” of selected Software from The Foundry (not available for all products or in
all regions ormarkets). A Free License lasts a limited specified period on the expiry of which the Softwarewill cease to
function; in normal circumstances a replacement to cover a new, time limited, period will be issued. Licensee shall use
the Software on only one computer at a time.

2.3 If Licensee has purchased a License that permits “non-interactive” use of the Software (“Headless Rendering”),
Licensee is authorized to use a non-interactive version of the Software for rendering purposes only (i.e. without a
user, in a non-interactive capacity) and shall not use such Software on workstations or otherwise in a user-interactive
capacity. Headless Rendering is not available on all products. In all cases except MODO (in respect of which there is
no limit on the amount of Headless Rendering allowed), Headless Rendering licenses are limited to one computer
such that the number of computers on which Headless Rendering can be carried out is limited to the number of valid
Licenses that have been purchased.
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3. RESTRICTIONS ON USE

Please note that in order to guard against unlicensed use of the Software a license key is required to
access and enable the Software (other than Softwarewhich is licensed under the Personal Learning Edition
model – see clause 2.2 (b) above). Licensee is authorized to use the Software inmachine readable, object code form
only (subject to clause 4), and Licensee shall not: (a) assign, sublicense, sell, distribute, transfer, pledge, lease, rent,
lend, share or export the Software, the Documentation or Licensee's rights under this EULA; (b) alter or circumvent
the license keys or other copy protectionmechanisms in the Software or reverse engineer, decompile, disassemble or
otherwise attempt to discover the source code of the Software; (c) (subject to clause 4) modify, adapt, translate or
create derivative works based on the Software or Documentation; (d) use, or allow the use of, the Software or
Documentation on any project other than a project produced by Licensee (an "Authorized Project") or to provide a
service (whether or not any charge ismade) to any third party; (e) allow or permit anyone (other than Licensee and
Licensee's authorized employees to the extent they areworking on an Authorized Project) to use or have access to
the Software or Documentation; (f) copy or install the Software or Documentation other than as expressly provided
for in this EULA; or (g) take any action, or fail to take action, that could adversely affect the trademarks, service
marks, patents, trade secrets, copyrights or other intellectual property rights of The Foundry or any third party with
intellectual property rights in the Software (each, a "Third Party Licensor"). For purposes of this clause 3, the term
"Software" shall include any derivatives of the Software.

Unless Licensee has purchased an Individual License, if the Software ismoved fromone computer to another, the
issuing of replacement or substituted license keys is subject to and strictly in accordancewith The Foundry’s License
Transfer Policy, which is available on The Foundry’s website and which requires a fee to be paid in certain
circumstances. The Foundry may from time to time and at its sole discretion vary the terms and conditions of the
License Transfer Policy.

4. SOURCE CODE

Notwithstanding that clause 1 defines “Software” as an object code version and that clause 3 provides that Licensee
may use the Software in object code form only:

4.1 if The Foundry has agreed to license to Licensee (including by way of providing SDKs, upgrades, updates or
enhancements/customization) source code or elements of the source code of the Software, the intellectual property
rights in which belong either to The Foundry or to a Third Party Licensor (“Source Code”), Licensee shall be licensed to
use the Source Code as Software on the terms of this EULA and: (a) notwithstanding clause 3 (c) Licenseemay use
the Source Code at its own risk in any reasonable way for the limited purpose of enhancing its use of the Software
solely for its own internal business purposes and in all respects in accordancewith this EULA; (b) Licensee shall in
respect of the Source Code comply strictly with all other restrictions applying to its use of the Software under this
EULA as well as any other restriction or instruction that is communicated to it by The Foundry at any time during the
Agreement (whether imposed or requested by The Foundry or by any Third Party Licensor);

4.2 to the extent that the Software links to any open source software libraries (“OSS Libraries”) that are provided to
Licenseewith the Software, nothing in the Agreement shall affect Licensee’s rights under the licenses on which the
relevant Third Party Licensor has licensed theOSS Libraries, as stated in theDocumentation. To the extent that Third
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Party Licensors have licensed OSS Libraries on the terms of v2.1 of the Lesser General Public License issued by the
Free Software Foundation (see http://www.gnu.org/licenses/lgpl-2.1.html) (the “LGPL”), thoseOSS Libraries are
licensed to Licensee on the terms of the LGPL and are referred to in this clause 4.2 as the LGPL Libraries. The
Foundry will at any time during the three year period starting on the date of the Agreement, at the request of
Licensee and subject to Licensee paying to The Foundry a charge that does not exceed The Foundry’s costs of doing
so, provide Licenseewith the source code of the LGPL Libraries (the “LGPL Source”) in order that Licenseemay
modify the LGPL Libraries in accordancewith the LGPL, together with certain object code of the Software necessary
to enable Licensee to re-link any modified LGPL Library to the Software (he “Object”); and

4.3 notwithstanding any other term of the Agreement The Foundry gives no express or implied warranty,
undertaking or indemnity whatsoever in respect of the Source Code, theOSS Libraries (including the LGPL Libraries),
the LGPL Source or theObject, all of which are licensed on an “as is” basis, or in respect of any modification of the
Source Code, theOSS Libraries (including the LGPL Libraries) or the LGPL Sourcemade by Licensee (“Modification”).
Licenseemay not use theObject for any purpose other than its use of the Software in accordancewith this EULA.
Notwithstanding any other term of the Agreement, The Foundry shall have no obligation to provide support,
maintenance, upgrades or updates of or in respect of any of the Source Code, theOSS Libraries (including the LGPL
Libraries), the LGPL Source, theObject or any Modification. Licensee shall indemnify The Foundry against all liabilities
and expenses (including reasonable legal costs) incurred by The Foundry in relation to any claim asserting that any
Modification infringes the intellectual property rights of any third party.

5. BACK-UP COPY

Licenseemay store one copy of the Software and Documentation off-line and off-site in a secured location within
theHomeCountry that is owned or leased by Licensee in order to provide a back-up in the event of destruction by
fire, flood, acts of war, acts of nature, vandalism or other incident. In no event may Licensee use the back-up copy of
the Software or Documentation to circumvent the usage or other limitations set forth in this EULA.

6. OWNERSHIP

Licensee acknowledges that the Software (including, for the avoidance of doubt, any Source Code that is licensed to
Licensee) and Documentation and all related intellectual property rights and other proprietary rights are and shall
remain the sole property of The Foundry and the Third Party Licensors. Licensee shall not remove, or allow the
removal of, any copyright or other proprietary rights notice included in and on the Software or Documentation or
take any other action that could adversely affect the property rights of The Foundry or any Third Party Licensor. To
the extent that Licensee is authorized to make copies of the Software or Documentation under this EULA, Licensee
shall reproduce in and on all such copies any copyright and/or other proprietary rights notices provided in and on
thematerials supplied by The Foundry hereunder. Nothing in the Agreement shall be deemed to give Licensee any
rights in the trademarks, servicemarks, patents, trade secrets, confidential information, copyrights or other
intellectual property rights of The Foundry or any Third Party Licensor, and Licensee shall be strictly prohibited from
using the name, trademarks or servicemarks of The Foundry or any Third Party Licensor in Licensee's promotion or
publicity without The Foundry's express written approval.

Subject to clause 4.3, The Foundry undertakes (the “Undertaking”) to defend Licensee or at The Foundry’s option
settle any claim brought against Licensee alleging that Licensee’s possession or use of the Software or
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Documentation in accordancewith the Agreement infringes the intellectual property rights of a third party in the
same country as Licensee (“Claim”) and shall reimburse all reasonable losses, damages, costs (including reasonable
legal fees) and expenses incurred by or awarded against Licensee in connection with any such Claim, provided that
the undertaking shall not apply where the Claim in question is attributable to possession or use of the Software or
Documentation other than in accordancewith the Agreement, or in combination with any hardware, software or
service not supplied or specified by The Foundry. TheUndertaking is conditional on Licensee giving written notice of
the Claim to The Foundry as soon as reasonably possible, cooperating in the defence of the Claim and not making
any admission of liability or taking any step prejudicial to the defence of the Claim. If any Claim ismade, or in The
Foundry's reasonable opinion is likely to bemade, against Licensee, The Foundry may at its sole option and expense
(a) procure for Licensee the right to continue using the Software, (b) modify the Software so that it ceases to be
infringing, (c) replace the Softwarewith non-infringing software, or (d) terminate the Agreement immediately by
notice in writing to Licensee and refund the License Fee (less a reasonable sum in respect of Licensee's use of the
Software to the date of termination) on return of the Software and all copies. TheUndertaking constitutes Licensee's
exclusive remedy and The Foundry's only liability in respect of Claims.

7. LICENSE FEE

Licensee acknowledges that the rights granted to Licensee under this EULA are conditional on Licensee's payment in
full of the license fee payable in connection with the Agreement (the "License Fee").

8. UPGRADES/ENHANCEMENTS

If the Licensee has paid an annually renewable fee for access to support, upgrades and updates for the Software
("Annual Upgrade and Support Programme"), this is subject to the terms and conditions for the Annual Upgrade and
Support Programme available on The Foundry's website. The Foundry may from time to time and at its sole
discretion vary the terms and conditions of the Annual Upgrade and Support Programme.

9. TAXES AND DUTIES

Licensee agrees to pay, and indemnify The Foundry from claims for, any local, state or national tax (exclusive of taxes
based on net income), duty, tariff or other impost related to or arising from the transaction contemplated by the
Agreement.

10. LIMITED WARRANTY

10.1 Subject to clause 10.3, The Foundry warrants that, for a period of ninety (90) days after Licensee first
downloads the Software (“Warranty Period”): (a) that the Softwarewill, when properly used on an operating system
for which it was designed, perform substantially in accordancewith the functions described in theDocumentation;
and (b) that the Documentation correctly describe the operation of the Software in all material respects. If, within
theWarranty Period, Licensee notifies The Foundry in writing of any defect or fault in the Software as a result of
which it fails to perform substantially in accordancewith theDocumentation, The Foundry will, at its sole option,
either repair or replace the Software, provided that Licenseemakes available all the information that may be
necessary to identify, recreate and remedy the defect or fault. This warranty will not apply to any defect or fault
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caused by unauthorised use of or any amendment made to the Software by any person other than The Foundry. If
Licensee is a consumer, thewarranty given in this clause is in addition to Licensee’s legal rights in relation to any
Software or Documentation that is faulty or not as described.

10.2 The Foundry does not warrant that the Software or Documentation will meet Licensee's requirements or that
Licensee's use of the Softwarewill be uninterrupted or error free.

10.3 If Licensee purchases a license of the Software that is of a fixed termduration, theWarranty Period in clause
10.1 shall apply only to Licensee’s first purchase of such license and not to any subsequent renewal(s) even if a
renewal involves another download.

11. INDEMNIFICATION

Licensee agrees to indemnify, hold harmless and defend The Foundry, the Third Party Licensors and The Foundry's
and each Third Party Licensor’s respective affiliates, officers, directors, shareholders, employees, authorized resellers,
agents and other representatives from all claims, defence costs (including, but not limited to, legal fees), judgments,
settlements and other expenses arising fromor connected with any claim that any authorised or unauthorised
modification of the Software or Documentation by Licensee or any person connected with Licensee infringes the
intellectual property rights or other proprietary rights of any third party.

12. LIMITATION OF LIABILITY TO BUSINESS USERS

This clause applies where Licensee is a business user. Licensee acknowledges that the Software has not been
developed to meet its individual requirements, and that it is therefore Licensee’s responsibility to ensure that the
facilities and functions of the Software as described in theDocumentationmeet such requirements. The Software
and Documentation is supplied only for Licensee’s internal use for its business, and not for any re-sale purposes or
for the provision of services to third parties. The Foundry shall not under any circumstances whatever be liable to
Licensee, whether in contract, tort (including negligence), breach of statutory duty, or otherwise, arising under or in
connection with the Agreement for loss of profits, sales, business, or revenue, business interruption, loss of
anticipated savings, loss or corruption of data or information, loss of business opportunity, goodwill or reputation or
any indirect or consequential loss or damage. In respect of any other losses, The Foundry’smaximumaggregate
liability under or in connection with the Agreement whether in contract, tort (including negligence) or otherwise, shall
in all circumstances be limited to the greater of US$5000 and a sumequal to the License Fee. Nothing in the
Agreement shall limit or exclude our liability for death or personal injury resulting fromour negligence, fraud or
fraudulent misrepresentation or for any other liability that cannot be excluded or limited by applicable law. This
EULA sets out the full extent of our obligations and liabilities in respect of the supply of the Software and
Documents. Except as expressly stated in this EULA, there are no conditions, warranties, representations or other
terms, express or implied, that are binding on The Foundry. Any condition, warranty, representation or other term
concerning the supply of the Software and Documentation whichmight otherwise be implied into, or incorporated
in, the Agreement, whether by statute, common law or otherwise, is excluded to the fullest extent permitted by law.
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13. LIMITATION OF LIABILITY TO CONSUMERS

This clause applies where Licensee is a consumer. Licensee acknowledges that the Software has not been developed
to meet Licensee’s individual requirements, and that it is therefore Licensee’s responsibility to ensure that the
facilities and functions of the Software as described in theDocumentationmeet such requirements. The Software
and Documentation are only supplied for Licensee’s domestic and private use. Licensee agrees not to use the
Software and Documentation for any commercial, business or re-sale purposes, and The Foundry has no liability to
Licensee for any loss of profit, loss of business, business interruption, or loss of business opportunity. The Foundry
is only responsible for loss or damage suffered by Licensee that is a foreseeable result of The Foundry’s breach of the
Agreement or its negligence but The Foundry is not responsible for any loss or damage that is not foreseeable. Loss
or damage is foreseeable if they were an obvious consequence of a breach or if they were contemplated by Licensee
and The Foundry at the time of forming the Agreement. Ourmaximumaggregate liability under or in connection
with the Agreement, whether in contract, tort (including negligence) or otherwise, shall in all circumstances be limited
to a sumequal to the greater of US$5000 and a sumequal to the License Fee. Nothing in the Agreement shall limit
or exclude our liability for death or personal injury resulting fromour negligence, fraud or fraudulent
misrepresentation or for any other liability that cannot be excluded or limited by applicable law.

14. TERM; TERMINATION

The Agreement is effective upon Licensee's download of the Software, and the Agreement will remain in effect until
termination. Licenseemay terminate the Agreement at any time on written notice to The Foundry. If Licensee
breaches the Agreement, The Foundry may terminate the License by notice to Licensee. If the Agreement is
terminated, the Licensewill cease immediately and Licenseewill either return to The Foundry all copies of the
Software and Documentation in Licensee's possession, custody or power or, if The Foundry directs in writing,
destroy all such copies. In the latter case, if requested by The Foundry, Licensee shall provide The Foundry with a
certificate confirming that such destruction has been completed.

15. CONFIDENTIALITY

Licensee agrees that the Software (including, for the avoidance of doubt, any Source Code that is licensed to
Licensee) and Documentation are proprietary to and the confidential information of The Foundry or, as the case
may be, the Third Party Licensors, and that all such information and any related communications (collectively,
"Confidential Information") are confidential and a fundamental and important trade secret of The Foundry and/or
the Third Party Licensors. If Licensee is a business user, Licensee shall disclose Confidential Information only to
Licensee's employees who areworking on an Authorized Project and have a "need-to-know" such Confidential
Information, and shall advise any recipients of Confidential Information that it is to be used only as expressly
authorized in the Agreement. Licensee shall not disclose Confidential Information or otherwisemake any
Confidential Information available to any other of Licensee's employees or to any third parties without the express
written consent of The Foundry. Licensee agrees to segregate, to the extent it can be reasonably done, the
Confidential Information from the confidential information andmaterials of others in order to prevent commingling.
Licensee shall take reasonable security measures, whichmeasures shall be at least as great as themeasures Licensee
uses to keep Licensee's own confidential information secure (but in any case using no less than a reasonable degree
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of care), to hold the Software, Documentation and any other Confidential Information in strict confidence and safe
custody. The Foundry may request, in which case Licensee agrees to comply with, certain reasonable security
measures as part of the use of the Software and Documentation. This clause shall not apply to any information that
is in or comes into the public domain, or was in Licensee’s lawful possession before receipt or which Licensee
develops independently and without breach of this clause. Licensee acknowledges that monetary damagesmay not
be a sufficient remedy for unauthorized disclosure of Confidential Information, and that The Foundry shall be
entitled, without waiving any other rights or remedies, to such injunctive or other equitable relief asmay be deemed
proper by a court of competent jurisdiction.

16. INSPECTION AND INFORMATION

16.1 Unless Licensee is a consumer, Licensee shall advise The Foundry on demand of all locations where the
Software or Documentation is used or stored. Licensee shall permit The Foundry or its authorized agents to audit all
such locations during normal business hours and on reasonable advance notice.

16.2 The Softwaremay includemechanisms to collect limited information from Licensee’s computer(s) and transmit
it to The Foundry. Such information (the “Information”) may include details of Licensee’s hardware, details of the
operating system(s) in use on such hardware and the profile and extent of Licensee’s use of the different elements of
the Software. The Foundry may use the Information to (a) model the profiles of usage, hardware and operating
systems in use collectively across its customer base in order to focus development and support, (b) to provide
targeted support to individual customers, (c) to ensure that the usage of the Software by Licensee is in accordance
with the Agreement and does not exceed any user number or other limits on its use, and (d) to advise Licensee about
service issues such as available upgrades andmaintenance expiry dates. To the extent that any Information is
confidential to Licensee it shall be treated as such by The Foundry. To the extent that any Information constitutes
personal data for the purposes of the Data Protection Act 1998 it shall be processed by The Foundry in accordance
with that Act and with The Foundry’s privacy policy (see http://www.thefoundry.co.uk/privacy/). Licensee
undertakes to make all of users of the Software aware of the uses which The Foundry will make of the Information
and of the terms of The Foundry’s privacy policy.

17. U.S. GOVERNMENT LICENSE RIGHTS

All Software, including all components thereof, and Documentation qualify as “commercial items,” as that term is
defined at Federal Acquisition Regulation (“FAR”) (48 C.F.R.) 2.101, consisting of “commercial computer software”
and “commercial computer software documentation” as such terms are used in FAR 12.212. Consistent with FAR
12.212 and DoD FAR Supp. 227.7202-1 through 227.7202-4, and notwithstanding any other FAR or other
contractual clause to the contrary in any agreement into which this Agreement may be incorporated, a government
end user will acquire the Software and Documentation with only those rights set forth in this Agreement. Use of
either the Software or Documentation or both constitutes agreement by the government that all Software and
Documentation are “commercial computer software” and “commercial computer software documentation,” and
constitutes acceptance of the rights and restrictions herein. The Software is the subject of the following notices:

* Copyright © 2001 - 2015 The Foundry Visionmongers Limited. All Rights Reserved.

* Unpublished-rights reserved under the Copyright Laws of theUnited Kingdom.
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18. SURVIVAL.

Clause 6 and clauses 9 to 20 inclusive shall survive any termination or expiration of the Agreement.

19. IMPORT/EXPORT CONTROLS

To the extent that any Softwaremade available under the Agreement is subject to restrictions upon export and/or
re-export from theUnited States, Licensee agrees to comply with, and not act or fail to act in any way that would
violate, the applicable international, national, state, regional and local laws and regulations, including, without
limitation, the United States Foreign Corrupt Practices Act, the Export Administration Act and the Export
Administration Regulations, as amended or otherwisemodified from time to time, and neither The Foundry nor
Licensee shall be required under the Agreement to act or fail to act in any way which it believes in good faith will
violate any such laws or regulations.

20. MISCELLANEOUS

Unless Licensee is a consumer, the Agreement is the exclusive agreement between the parties concerning its subject
matter and supersedes any and all prior oral or written agreements, negotiations, or other dealings between the
parties concerning such subject matter. Licensee acknowledges that Licensee has not relied upon any representation
or collateral warranty not recorded in the Agreement inducing it to enter into the Agreement. The Agreement may be
modified only in writing. The failure of either party to enforce any rights granted under the Agreement or to take
action against the other party in the event of any such breach shall not be deemed awaiver by that party as to
subsequent enforcement of rights or subsequent actions in the event of future breaches. The Agreement and any
dispute or claim arising out of or in connection with it or its subject matter or formation (including, unless Licensee is
a consumer, non-contractual disputes or claims) shall be governed by, and construed in accordancewith English Law
and the parties irrevocably submit to the non-exclusive jurisdiction of the English Courts, subject to any right that a
consumermay have to bring proceedings or to have proceedings brought against them in a different jurisdiction.

If The Foundry fails to insist that Licensee performs any obligation under the Agreement, or delays in doing so, that
will not mean that The Foundry has waived its rights.

Unless Licensee is a consumer, Licensee agrees that The Foundry may refer to Licensee as a client or a user of the
Software, may display its logo(s) for this purpose andmay publish quotations and testimonials from Licensee, its
directors, partners, officers or employees. The Foundry agrees to promptly cease any such use on Licensee’s written
request.

The Foundry and Licensee intend that each Third Party Licensormay enforce against Licensee under the Contracts
(Rights of Third Parties) Act 1999 (the “Act") any obligation owed by Licensee to The Foundry under this EULA that is
capable of application to any proprietary or other right of that Third Party Licensor in or in relation to the Software.
The Foundry and Licensee reserve the right under section 2(3)(a) of the Act to rescind, terminate or vary this EULA
without the consent of any Third Party Licensor.

Copyright © 2015 The Foundry Visionmongers Limited. All Rights Reserved. Do not duplicate.
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